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Problems with our UART implementation

/* Infinite loop */
while (1) {

= Remember the final solution:| ™ Gsasr ox @aeto, vsare s @azzo)) ;

}
O This solution is a blocking implementation since

USART_Rx will not return until data is received

O Better solution to call USART _Rx function only if a
character can be found in the buffer

O An other good way to use interrupt

= Better to start a new project in the same way
done before

= See the following sides to remember stating a
new project
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Strating with a new project

" File->New->Project->Silicon Labs MCU Project:

==+ New Silicon Labs Project O X
Project setup ﬁ
Select the board, part, and SDK for the project.
Boards:
Search ‘ A4

EFM32 Giant Gecko Starter Kit board (BRD2200A Rev AD3) *

Part:

| Search ‘ ™

| EFM32GG990F1024 |

SDK:
|Gecko SDK Suite: MCU 5.8.3.0, Micrium OS Kernel 5.7.0 (v2.6.3) (I\Simplicity_studio\devel V| (7]

Manage SDKs...

@ < Back Finish Cancel
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Strating with a new project

" File->New->Project->Silicon Labs MCU Project:

== New Silicon Labs Project O X
Project setup @
Select the board, part, and SDK for the project.
Boards:
Search | w

EFM32 Giant Gecko Starter Kit board (BRD2200A Rev A03) *

Part:

| Search | W

| EFM32GG990F1024 |

SDK:

|Gecko SDK Suite: MCU 5.8.3.0, Micrium OS Kernel 5.7.0 (v2.6.3) (I\Simplicity_studio\devel

Manage SDKs...

@ < Back Finish Cancel
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«= New Silicon Labs Project O X
Project setup E
Select the type of project.
Project Type:

@ Empty C Program - Create an empty C executable project.

(O Empty C++ Program - Create an empty C++ executable project.
(O Example - Create a working example for the part.

(O Library - Create an empty static library project.

(O Simplicity Configurator Program - Create a project whose contents are driven from
Simplicity Configurator.

@ < Back Finish Cancel
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Strating with a new project

= Give project name and location, and set
Copy content:

«== New Silicon Labs Project O X
Project Configuration @
Select the project name and location.

Project name: | UART_COM ‘

Use default location
CA\Users\krebesz\SimplicityStudio\v4_workspace\UART_COM Browse...
With project files:
(O Link to sources
(O Link sdk and copy project sources
(@ Copy contents

@ < Back Mext = Cancel
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Project created — start programming

"= Main.c can be also renamed to UART_COM.c

= Although an empty C project has been created a
program skeleton is offered automaticly

[5 Project Explorer &2 =% < = 0O || UART_COM.c &3
(£5 STK3700_blink [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 - (] 1 #include "em device.h"
(25 STK3700 button [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 é #include "em chip.h"
v &5 UART_COM [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 - Gec|| =~ _ _
: 4=int main (void)
kit Includes 5 1
= CMSIS o /* Chip errata */
= emlib 7 CHIP Init():
v [ SIC a
lel UART_COM.c G /* Infinite loop */
10  while (1) {
11}

12 }

4
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Files to be added to the project

= Search the library where Simplicity Studio is
installed

O Contains include (inc: *.c) and source (src: *.h) files:
i:\Simplicity _studio\developer\sdks\gecko sdk_suite\v2.6\platform\emlib\

" Following files have to be drag-and-dropped into
emlib library of the project (see next slide):
0 em_cmu.c (clock management unit)
O em_gpio.cC
O em_usart.c
O em_core.cC

O em_emu.c (energy management unit)
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Files to be added to the project

* Furthermore they have to be included into the
program:

L Project Explorer & =% ¥ = 0O || [¢*UAR] COM.c [ em_device.h
(=5 STK3700_blink [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 - Gecko SD
(% STK3700_button [GNU ARM v7.2. - Debug] [EFM32GG990F1024 - Gecko §
(&5 UART_COM [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 - Gecko SDK §

v =% UART_COM_Development [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024

#include "em_device.h"*\
#include "em chip.h"
#include "em cmu.h"

#include "em gpio.h"
#include "em usart.h"

1
2
-
-
6

Y Includes #include "em core.h"
= CMSIS #include "em emu.h" 4/
(- c emlib i
1, L em_cmu.c ~int main(void)
e lg em_core.c 0 {
N lg] em_emu.c - /* Chip errata */
I - 2 CHIP Init();
—1 l¢ em_gpio.c - _
L em_system.c 4
Ld mﬂJﬂan£<4) 5 /* Infinite loop */
v [ SIC o while (1) {
le) UART DEV_COM.c 7 }
I"I?. ITANT DNem b= TTRITT ATYRA .77 784 Mmoo TFIRE AT MAMAMATAMATY A ol O 5 E: }
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Code to start with

Use the following code as a reference for your work (continue from previous result):

#include "em_device.h"
#include "em_chip.h"
#include "em_cmu.h"
#include "em_gpio.h"
#include "em_usart.h"
#include "em_core.h"
#include "em_emu.h"

int main(void)
{

/* Chip errata */
CHIP_Init();

// Enable clock for GPIO
CMU->HFPERCLKENO |= CMU_HFPERCLKENO_GPIO;

// Set PF7 to high
GPIO_PinModeSet(gpioPortF, 7, gpioModePushPull, 1);

// Configure UARTO
// (Now use the "emlib" functions whenever possible.)

// Enable clock for UARTO
CMU_ClockEnable(cmuClock_UARTO, true);

// Initialize UARTO (115200 Baud, 8N1 frame format)

// To initialize the UARTO, we need a structure to hold

// configuration data. It is a good practice to initialize it with

// default values, then set individual parameters only where needed.
USART _InitAsync_TypeDef UARTO init = USART _INITASYNC_DEFAULT;

USART _InitAsync(UARTO, &UARTO_init);
// USARTO: see in efm32ggf1024.h

// Set TX (PEO) and RX (PE1) pins as push-pull output and input resp.
// DOUT for TX is 1, as it is the idle state for UART communication
GPIO_PinModeSet(gpioPortE, 0, gpioModePushPull, 1);

// DOUT for RX is 0, as DOUT can enable a glitch filter for inputs,

// and we are fine without such a filter
GPIO_PinModeSet(gpioPortE, 1, gpioModelnput, 0);

// Use PEO as TX and PE1 as RX (Location 1, see datasheet (not refman))
// Enable both RX and TX for routing

UARTO->ROUTE |= UART_ROUTE_LOCATION_LOC1;

// Select "Location 1" as the routing configuration

UARTO->ROUTE |= UART_ROUTE_TXPEN | UART_ROUTE_RXPEN;

/* Infinite loop */
while (1) {
}

}

© BME-MIT
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Setting the terminal program

" Check UART (COM port number and its settings) in

Device Manager in Windows (now it is C9M4)

% Device Manager | s
File Action View Help
&= @ B b EEXG

@ Carmneras A
Ld Computer

== Disk drives

B8l Display adapters

= DVD/CD-ROM drives

i Firmware

#r Human Interface Devices

*& |DE ATA/ATAPI controllers

= Keyboards

[ | Memory technology devices

Q Mice and other pointing devices
3 Monitors
P Network adapters

Portable Devices
l v ? Ports (COM & LPT) v
& JLink CDC UART Port (COM4)
= Print queues v
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Setting the terminal program

= A PC-based terminal program is needed to get
access to COM4 port: an option is putty.exe

R PuTTY Configuration ? X B puTTY Configuration ? X
Category: Category:
Em Basic options for your PuT TY session Q-S_ESSion Options controlling local serial lines
. Logging . i . ~Logging .
& Terminal Spe:_:lfy_l‘he 2 ’UOI"I youwantto connectto 3 = Terminal Selecta senal line f \‘
- Keyboard Senalline Speed - Keyboard Serial line to connect to |co|\,q4 |
- Bell coms 115200 ] - Bell
- Features i - Features Configure the serial line
= Window ’ : . =-Window
. Appearance {JRaw () Telnet () Rlogin OSS)—'_ (@) Serial - Appearance Speed (baud) |‘I‘IBZDD |
- Behaviour Load. save or delete a stored session 1 ~Behaviour Data bits |3 |
- Translation s d Sessi - Translation
[-Selection aved -essions [ Selection s |'I |
- Colours | | - Colours Parity N
. ari one L
&= Connection Default Settings Load | Sae on
- Data —] -~ Data Flow control None ~
- Proxy - - Proxy
- Telnet - Telnet ‘
- Rlagin Delete - Rlogin \ 5 y
= [+-SSH
. Serial T - Serial

Close window on exit:
() Always () Never (@) Only on clean exit

About Help Cancel About Help I Open Il Cancel

6

- Méré hnika é .
© BME-MIT m Ini?orer?'\t:cciés Raeremgszerek llS“de

Tanszék



Non-blocking character reception

" Check our previous solution again
0 What does USART_Rx do(stay on it by mouse pointer)?

/* Infinite loop */
while (1) {
USART Tx (UARTO, USART Rx (URRTO) ) ;

} } uintB_t USART Rx (USART TypeDef *usart)
{

while (! (usart->STATUS & USRRT STATUS RXDATAV)) {
}

bblems 4" Search |2 Call H

return (uintf t)usart->RXDATRL;
am Cutput Console —

}

Press 'F2' for focus

O Operation: remains in while loop until in
USART_STATUS_RXDATAV bit flips to 1, then returns

with the received character (RXDATA)

e See 03_EFM32_Reference_manual EFM32GG-reference_manual.pdf
on page 481 (and next slide)

0 Blockmg can be avoided if we check the STATUS reg

ol Méréstechnika
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Non-blocking character reception

17.5.5 USARTN_STATUS - USART Status Register

oot |5 |glr|e|x|gr|x|c|a|s|g2e|x|e|e|zizec|e|o |~ fo|o || |~]|-]|o
Reset DDDDCIDFDDDODG
Access r | rr| | rx e fjrrlr ||l | x| o
F_
=T
5955 z L _(SE oo
Name F| x| 2|2 ElelelZ|olE|[z2|Z
_I>Q:I = }_l—_IUjLIJU-'
412|515 a I X |m | < | x| X
:)l'—mm > |_><E|—n:
L | |x|x o o
X | Q|F|F
il
u
7 RXDATAV 0 R RX Data Valid

Set when data is available in the receive buffer. Cleared when the receive buffer is empty.

= Non-blocking solution: check STATUS reg. and call
USART_Rx() function only if incoming character is
available
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Non-blocking character reception

= Search em_usart.h for a function that checks
STATUS register (if available, hopefully it is):

# Debug Adapters | 5% Outline 3 % s
®° USART_IntDisable(USART_TypeDef*, uint32_t) : voi
oS USART_IntEnable(USART _TypeDef®, uint32_t) : voic
e° USART_IntGet(USART_TypeDef®) : uint32_t

* @brief
Get USBRT STATUS register.
* @param[in] usart
Pointer to USART/URRT peripheral register block.

* @return
STATUS register wvalue.

44444444444444444444444444444444444444444444444444444444444444

- STATIC INLINE uint32 t [ELVUEFIAEe=ts (USART TypeDef *usart)

{
return usart->STRATUS;

- Méré hnika é .
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Non-blocking character reception
= Application of USART_StatusGet() function:

/* Infinite loop */
while (1) {
if I[USI!.RT_Statu sEet (URARTO) & USBRT_STRTUS_RKDRTELF] {
USART Tx(UARTO, USART Rx(UARTO));
}

}

= Even more elegant solution if we implement an
owh non-blocking function to receive characters

int USART RxNonblocking (USART TypeDef *usart)
{

int retvVal = -1; int ch:
ch = USART RxNonblocking (UARTO)
if (usart->STATUS & USART STATUS RXDHTHV} { if (ch !'= fj_) [
retVal = [1nt){u3art >RXDATA) ; USART Tx (UARTO, ch):;
} - ’ '
'

return retVal; L ) .
) Application of non-blocking function

(put it in the main function)

Implementation of non-blocking function
(put it before the main function)

- Méré hnika é .
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Non-blocking character reception

= Remark on USART_Tx() function:

O If data to be sent is too much even USART _Tx()
function can be blocking — have a look at USART_Tx()

/* Infinite loop */
while (1) f{
//USRRT StatusGet (USART TypeDef *usart)
if (USART StatusGet (UARTO0) & USART STATUS EXDATAV) ({
LGy (UARTO, USART Rx (UARTO));

} void USART Tx(USART TypeDef *usart, uintB_t data)

1 lln'

slems ¥ S

n Output Cons|  usart->TXDATA = (uint32 t)data;
}

Press 'F2' for focus

O Clearly seen that blocking may happen but “less
severe” —> USART_STATUS_ TXBL bit is checked in
STATUS register

- Méré hnika é .
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Non-blocking character reception

O USART_STATUS_TXBL bit (TXBL may appear in other registers- be careful)

17.5.5 USARTNn_STATUS - USART Status Register

0x010 2322|588 RIS e g2 e |sj8|lo|o rjejp | |m ||~ |0
Reset o|lo|lo|lo | oo~ | o | o|lo|lo | o
Access r v o v ok | @ x|l | x| o
'_
Ll s
- | =
518513 2|2l-Lb z 86|22
Name zlel@ |2 |s|ElaR E O|= |2 |8
T2 || x | Sfx Eld o WY
J|2 |3 o | x| 2fF X o g X
u.':':){)( o o
x |QIF |+
x|z
4] TXBL 1 R TX Buffer Level

Indicates the level of the transmit buffer. If TXBIL is cleared

TXBL is set whenever the transmit buffer is half-full or empty.

TXBL is set whenever the transmit buffer is empty,bnd if TXBIL is set,

See 03_EFM32_Reference_manual EFM32GG-reference_manual.pdf

© BME-MIT

on page 481
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Non-blocking character reception

1)
et
1)
@
et
1]
|
@
c
@
oo
1
Q
&=
=
=
=]
et
=
©
et
1)
=

O Operation of data transmission:

e Generated data is loaded into TX
Register only if TX Register is empty

— Otherwise data in TX Register is
overwritten and data loss may occur

 |f TX Buffer is empty data is loaded

TX Register to load data into TX Buffer ] ] )
into it from TX Register

e From TX Buffer data is sent out via
the communication line (UART)

e R=115200bps->1byte needs 70us
e T clk=1/14MHz=70ns->1000cycles

per bytel!ll
TX Buffer to send data to comm. line | I I I

A, ., e . Méréstechnika és .
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Interrupt-based character reception

= Problem with non-blocking character reception
O If the main program executes a long-lasting task before
repeated checking of character is done data loss may
occur

O To prevent that kind of data loss application of
interrupt can be a solution

Peripheral B Cortex- M3 NVIC

l SET EI\IA[n]'CLRENA[n] |
Active interrupt
Interrupt set clear IRQs + CFt’U 1
condition IF[n] 2 o p interrup
[ SETPEND[Nn]/ CLRPEND[n]
|
Software generated interrupt

BEEVEIEEOE BEEDHE

y

¥
N\
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IT initialization for a peripheral

= |nitialization of IT in a general case:

: : : : DONE
O Enabling peripheral (turn perif. on, config., etc.)| | iousy uarT init)
O Determination of IT-handling function
C
O Clear of IT flag belonging to the certain IT 0
M
 An IT request may be stuck from a previous state that can E
cause problem since after enabling IT a false interrupt can | °
take action. A stuck IF can be the consequence of a non- N
initialized peripheral (e.g. IT occurs on a floating input) v(\)/
O Enabling the IT of a certain peripheral
0 Clearing of global IT flag (if needed) .
O Enabling of global IT :
R

NOTE: THIS SLIDE COMES FROM THE INTERRUPT TOPIC OF LECTURES
USE THAT LECTURE AS A REFERENCE IF NEEDED
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Interrupt-based character reception
" Interrupt has to be enabled for UART

17.4 Register Map

03 _EFM32_Reference_manual _EFM32GG-reference_manual.pdf
See page 475

The offset register address is relative to the registers base address.

Ox040 USARTn_IF R Interrupt Flag Register
Ox044 USARTn_IFS WH Interrupt Flag Set Register
0x048 USARTn_IFC W1 Interrupt Flag Clear Register
Ox04C [ USARTn_IEM ] RW Interrupt Enable Register

17.5.20 USARTnN_IEN - Interrupt Enable Register

03 _EFM32_Reference_manual EFM32GG-reference_manual.pdf

See page 490
—
0x04C g g 83lslge syl g e rolv|g|oulcl2lg o ~low < ollal-]o
Reset ol|loco|lo|loc o|lo|lcao | o|lollelloc | o
== ||z ==z == |2=s)= =
Access rlzlg z z e |z el

r « Ll w4 i
Name S % < gl |5|6/35]|0 slela |2
LW W x| =% x| x < % | X
Clo s lalrFrlFe|z|xla)F|F

i |

S

2 RXDATAV 0 RW RX Data Valid Interrupt Enable

Enable interrupt on RX data.
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Interrupt-based character reception

O Check em_usart.h for interrupt enable function

5ZZ Tparam[ 1] USart
W No Adapters | E= Outline 2 - = g25 * Pointer to USRRT/UARRT peripheral register block.
R 0¥ ¥ 32
£+ USART InitPrsTrigger(USART TypeDef*, const USART ~ 8§27 * @param[in] flags
828 USBERT/UART interrupt source(s) to snable. Use one or more valid
2 interrupt flags for the USEART module (USART IF nnn) OR'ed together.

44444444444444444444444444444444444444444444444444444444444444444444444444444

31e  STATIC INLINE void [SfhNbgeen=+,E1300 (USART TypeDef *usart, uint32 t flags)
37 {

e ¥ USART _InitlrDA(const USART_InitlrDA_TypeDef®) : vc
oS USART_IntClear(USART _TypeDef*, uint32_t) : void
oS USART _IntDisable(USART_TypeDef*, uint32_t) : void
o ¥ USART _IntEnable(USART TypeDef*, uint32_t) : void
oS USART_IntGet(USART_TypeDef*) : uint32_t

ol USART_IntGetEnabled(USART_TypeDef*) : uint22_t

usart->IEN |= flags;

}

O Insert USART _IntEnable() function
flags = register content, here the 2" bit is interesting
(see previous slide)

e Check efm32_gg usart.h

#define USART_IEN_RXDATAV (Ox1UL << 2) /**< RX Data Valid Interrupt Enable */

e Code to be applied:

//USERT IntEnable (USART TypeDef *usart, uint32 t flags)
l USART IntE nable (UAETO, USART IEN RX DATAV)

/* Infinite loop */

i while (1) {

- Méré hnika é .
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Interrupt-based character reception
" |Interrupts have to be cleared (all ITs) for UART

O Check em_usart.h for interrupt clear function

= 8

ElER s o %k ¥
++  USART_InitPrsTrigger(USART_TypeDef*, const USART #
ef USART_InitlrDA{const USART_InitlrDA_TypeDef*) : v

® * USART IntClear(USART_TypeDef#, uint32_t) : void

SUSA.RTIntDlsabIe{USARTTypeDeﬁ‘ uint32_t) : void

e % USART IntEnable(USART TypeDef*, uint32_t) : void

ef USART_IntGet(USART_TypeDef*) . uint32_t

B No Adapters | 5% Qutline &2 * @param[in] flags
* Pending USART/UART interrupt source(s) to clear. Use one or more wval
* interrupt flags for the USART module (USART IF nnn) OR'ed together.
___STATIC INLINE veoid [SERNEERSAASTERY(USART TypeDef *usart, uint32 t flags)
{

> #if defined (USART HAS SET CLEAR)

usart—>IF CLR = flags;

e 5 USART IntGetEnabled(USART_ TypeDef*) : uint32_t
© 5 USART _IntSet(USART _TypeDef*, uint32_t) : void
® ® USART StatusGet(USART TypeDef#) : uint22 t

#else
usart
. #endif
}

[)I FC

= flags:; ]

17.5.19 USARTn_IFC - Interrupt Flag Clear Register

o8 |5 (g|R 8 |N (e8| | |8|s=|2e|sele|z]2je|z 2|00~ oo |v|o|a|]o

Reset olo|lo|lo|lololae oo o

Access = (=22 =2 222 =z =2 =

=l

Name AHEEIEEIEIE 9

clo |z ¥ @I Ee = 5 =
03 EFM32 Reference manual EFM32GG-reference_manual.pdf See page 489
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Interrupt-based character reception

O All bits in USARTn_IFC register have to be cleared

* A define can be found in efm32gg usart.h for that purpose:
#define _USART IFC_MASK Ox00001FFQUL /**< Mask for USART IFC */

O Insert USART _IntClear() function after UART init
O Code to be applied:

//USBRRT IntClear (USART TypeDef *usart, uint32 t flags)
USERT IntClear (UARTO, USART IFC MASK);

//USRRT IntEnable (USART TypeDef *usart, uint32 t flags)

USBRT IntEnable (URRT0, USRRT IEN RXDATRV);

/* Infinite loop */
while (1) {

O This step requires extra care: it is very probable that
the program would work but in general, not clearing IT
flags can cause a trouble
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Interrupt-based character reception

JUST DONE COMING NEXT

Peripheral N Cortex- M3 NVIC

BEOEEE

| SETENA[n)/ CLRENA[n] |

Active interrupt e
Interrupt set  clear IRQs R v interrupt
condition IF[n] i set clear
| SETPEND[n]/ CLRPENDI[n]

y

v
N\

Software generated interrupt

= So far UART peripheral-related IT has been dealt
with
= From now let’s see the core-related IT

. Méréstechnika és .
© BME-MIT Informaciés Rendszerek 255||de
Tanszék



Interrupt-based character reception

= Core-related IT- IT for the UART has to be enabled

0 em_decive.h + F3 (among included header files in at
the top of the program)
-> find in it efm32gg990f1024.h + F3
-> find in it core_cm3.h + F3
NVIC functions are needed

" |n core ~cm3.c search for

# No Adapters Outlme i :4:,@ \brief Enable Interrupt
H 1% W s @ % T 1499 ‘“details Enables a device specific interrupt in the
# NVIC GetVector ~1l 1500 \param [in] IRQn Device specific interrupt num
# NVIC_USER_IRQ OFFSET 1501 \note IRQn must not be negative.

i lI.'

__sTarIic_INLINE void | T I et (IROn Type IRQD)

if ((int32 t) (IRQn) >= 0)
{

®f _ MVIC_SetPriorityGrouping(uint32_t) : void
e ® _NVIC_GetPriorityGrouping(void) : uint32 t
e ® _NVIC_EnablelRQ{RQn_Type) : void

e ® _NVIC_GetEnablelRQ(IRQN_Type) : uint32_t
e ¥ _NVIC_DisablelRQ(IRQn_Type) : void

e ® _NVIC_GetPendingIRQ(IRQn_Type) : uint32_t
e %  NVIC SetPendinglRQ({IRQn_Type) : void

NVIC->ISER[(( I[Llirlt32_t] IEQn) >> 5UL)] = I[Llil’lt32_t]
}

- Méré hnika é .
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Interrupt-based character reception

O In core_cm3.c search for
« void _ NVIC EnablelRQ(IRQNn_Type IRQN)

— IRQn_Type IRQn + F3 to check the possible ITs to find:
UARTO_RX_IRQn = 20, /*I< 20 EFM32 UARTO_RX Interrupt */

O Code to be applied:

//USBRT IntClear (USERT TypeDef *usart, uint32 t flags)
USBRT IntClear(UARTO, USART IFC MASK);

//USRRT IntEnable (USART TypeDef *usart, uint32 t flags)

USBERT IntEnable (UART0, USART IEN RXDATAV);

[ /woid NVIC EnableIRQ(IRQOn T
~ NVIC EnableIRQ(UARTO RX IROm);

e TRON )

/* Infinite loop */
while (1) {
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Interrupt-based character reception

" Core-related IT-IT flags has to be cleared

0 em_decive.h + F3 (among included header files in at
the top of the program)
-> find in it efm32gg990f1024.h + F3
-> find in it core_cm3.h + F3
NVIC functions are needed

" In core cm3 C search for

# No Adapters = Outline 1 15 \brief Clear Pending Interrupt
Hl R o & 7 LEE:% \details Clears the pending bit of a device specific inter
® % _NVIC_GetPendinglRQ(IRQN_Type) : uint32_t ~ 1589 ‘param [in] IEQn Device specific interrupt number.
®® _NVIC_SetPendingIRQUIRQN_Type) : void 159¢ "31191:6 IRQn must not be negative.

® % _NVIC_ClearPendingIRQ(IRQn_Type) : void

®% _NVIC_GetActive(IRQn_Type) : uint22_t

e ® _ NVIC_SetPriority(IRQn_Type, uint32_t) : void

e ¥ _ NVIC_GetPriority(IRQn_Type) : uint32_t

of MNVIC_EncodePriority(uint32_t, uint32_t, uint32_t) : ui
®f NVIC_DecodePriority{uint32_t, uint32_t, uint32_t* co
e ® _NVIC_SetVector(IRQn_Type, uint32_t) : void

__ STATIC INLINE void iAo E-E R4 kR lanzle (TRON Type IRON)

if ((int32 t) (IRQn) >= 0)
{
NVIC->ICPR[(((uint32 t)IRQn) >> 5UL)] = (uint32 t) (1UL <

}
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Interrupt-based character reception

O In core_cm3.c search for
« void _ NVIC ClearPendinglRQ(IRQN_Type IRQN)

— IRQn_Type IRQn + F3 to check the possible ITs to find:
UARTO_RX_IRQn = 20, /*I< 20 EFM32 UARTO_RX Interrupt */

O Code to be applied:

( //USBRT IntClear (USERT TypeDef *usart, uint32 t flags) )
USART IntClear (URART0, USART IFC MASK);
B N - UART Perif. IT
//USERT TIntEnable (USART TypeDef *usart, uint32 t flags) || clearand enable
\ USRRT_IntEnable (UARTO, USELRT_IEH_RXDETR?]; y
"  /void  NUIC CIE . - N\
l ~ RVIC | ClearPendlngIRQEUﬂRTG RX IRQH}
Proc. core IT
//void  NVIC EnableIRQ(IRQn Type IRQn) clear and enable
NVIC EnableIRQ[U&RTQ RX IRQI]]I
.~ _ J
/* Infinite loop */
while (1) {
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Interrupt-based character reception

" |Ts have just been correctly configured
O When a character is received at UARTO, IT is generated

" |T function has to be implemented
0 What should happen when IT event occurs
O Check startup _gcc_efm32gg.s in Project Explorer

[ Project Explorer 3| = 5% ¥ = O ||[d *UART_COM.c | em_deviceh | efm32gg990f1.. L em_usartc | efm32gg_usarth

&% STK3700 blink [GNU ARM v7.2.1 - Dg|| 103 .leong I2C1 IRQHandler /* 10 — T12C1 */
5 STK3700 button [GNU ARM v7.2.1 -0l 104 .long GPIO ODD IRQHandler f* 11 - GPIOC ODD */
—_ L = llll."ll - _ mT E '-‘\.':'"
25 UART_COM [GNU ARM v7.2.1 - Depuf| 0% 1909 Eigié—iigiangier s e
) o 106 .leong andler /% 13 - TI 2wy
w 5 GMNU ARM - — _ N _
U:‘R_T-CQM-DEVE'OPT”EHT-“”' | 107 .long TIMER3 IRQHandler /* 14 — TIMER3 */
% Binaries 108 .long USART1 RX IRQHandler /* 15 — USERT1 RX */
il Includes 109 .long USERT1 TX IRQHandler /* 16 — USERRT1 TX */
v = CMSIS 110 .long LESENSE IRQHandler /* 17 — LESENSE */
v (= EFM32GG 111 .long USART2 RX IRQHandler /* 18 — USRRT2 RX */
8| startup_gcc_efm32gg.s e -long 0. /* 18 - USRRT2_TX */
B Sygtemm' 113 .long URETO EX IRQHandler /* 20 - URRTO RX */
b - ' 114 .long URRTU TX TIRQHandler f/* 21 - UBRRTOD TX */
= emil 115 .long UART1 RX IROHandler /* 22 — URRT1 RX */
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Interrupt-based character reception

O Check startup_gcc_efm32gg.s in Project Explorer
O Search for UARTO_RX_IRQHandler:

[ Project Explorer 22| = % ¥ = O ||[d *UART_COM.c T em_deviceh | efm32gg990f1.. i em_usartc | efm32gg_usarth
(5 STK3700 blink [GNU ARM v7.2.1 - Dej| 103 .long I2C1 IRQHandler f* 10 - 12C1 */
(5 STK3700_button [GNU ARM v7.2.1 - T 104 .long GPIO ODD IRQHandler f* 11 - GPIC ODD * /
B y = Pk — 7T - &/
5 UART_COM [GNU ARM v7.21 - Debuf| 10°  -1ong giﬁg—iigianiﬂ P
: . 106 .long andler /* 13 - TIMERZ *,
w =5 GNU ARMI o — _ - _
Uf":{r-CQM-De”e'Opme”t-“”' | 107 .long TIMER3 IRQHandler /* 14 — TIMER3 */
*: Binaries 108 .long USART1 RX IRQHandler /* 15 — USRRT1 RX */
k! Includes 109 .long USRRT1 TX IRQHandler /* 16 - USBRT1 TX */
~ (= CMSIS 110 .long LESENSE IRQHandler /* 17 - LESENSE */
+ (= EFM32GG 111 .long USART2 RX IRQHandler /* 18 - USART2 RX */
|8 startup_gcc_efm32gg.s 112 -long ——mBlo JX TROOINJICT /* 19 - USRERTZ TX */
B WSTEWIW' 113 .long URET(0 EX IRQHandler /% 20 - L‘P.RTI_S_RK */
b - ' 114 .long UART0 TX TRQHandler /* 21 - URRTO TX */
= emil 115 .long UART1 RX IROHandler /* 22 - UART1 RX */

O UARTO_RX IRQHandler is a weak function so |t can be
overdefined in the program without causing any error:

/* Macro to define default handlers. Default handler
* will be weak symbol and just dead loops. They can be
* overwritten by other handlers.
¥ lln'

.macro def irg handler handler name
.weak ‘handler name

.set tnandler name, Default Handler o és _
.endm Rendszerek 31.slide




Interrupt-based character reception

O Implementation of IT function in the program code

0 UART_RX_IRQHandler function has to be defined
before the main function

e During IT the received data has to be sent to UART
O Code to be applied:

uint8 t rx data; // a variable is defined for USERT Tx data
// (whose type is uintf t)
“void UARTO RX IRQHandler (veid){ // definition of IT function:
rx data=USART Rx (URRTO); // data read from URRTO and stored in rx data
USART Tx (URRTO, rx data):; // rx data 1s sent to UARRTO
USART IntClear (UARTO, USART IFC MASK); // IT flag is cleared

}

O Note: no input parameter and no return value
-> void func(void){
what happens during IT;
clear IT flag; }
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Appendix: code —a working version

#include "em device.h"
#include "em chip.h"
#include "em cmu.h"
#include "em gpio.h"
#include "em usart.h"
#include "em core.h"
#include "em emu.h"

-

=] Oy N o= Lo [N

(s s

% uint8 t rx data;
10
1l=woid UVARTO RX IRQHandler (void) {

12 rx_data=USART Rx (UARTO);

13 USART Tx (URRTO, rx data);

14 USRRT IntClear (UARTO, USART IFC MASK);

=
oy LT
ot

T=int main (void)

{

=
oo

/* Chip errata */
CHIP Init();

B3 B
=

// Enable clock for GPIC
CMU->HFFEECLEEND |= CMU_HFPERCLKEND_GPIG;

| o

[0

// Set PF7 to high
GPIO_ PinModeSet (gpioPortF, 7, gpicModePushPull, 1);

] ]
=1 o LN L D

[0

28 // Configure UARRTO
C // (Now use the "emlib" functions whenever possible.)
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Appendix: code —a working version

30

31 // Enable clock for URRTO

32 CMU ClockEnable (cmuClock UARTO, true):

272

34

35 // Initialize UARTO (115200 Baud, 8N1 frame format)

36

37 // To 1nitialize the UART0O, we need a structure to hold

38 // configuration data. It is a good practice to initialize it with
35 // default wvalues, then set individual parameters only where needed.
40 USART InitAsync TypeDef UARTO init = USART INITASYNC DEFAULT;

41

42 USART InitAsync(URRTO, &UARRTO init);

43 // USBRTO: see in efm32ggfliz24.h

44

5 // Set TX (PEO) and RX (PEl) pins as push-pull output and input resp.
46 // DOUT for T is 1, as it is the idle state for UART communication
7 GPIO_PinModeSet (gpicPortE, 0, gpioModePushPull, 1);

48 // DOUT for RX is 0, as DOUT can enable a glitch filter for inputs,
49 // and we are fine without such a filter

50 GPIO_PinModeSet (gpicPortE, 1, gpioModeInput, 0):

51

52 // Use PED as TX and PEl as RX (Location 1, see datasheet (not refman))
53 // Enable both R¥X and TX for routing

54 URRTOD->ROUTE |= UPLRT_ROUTE_LGCELT I GH_LCH: 1;

55 // Select "Location 1" as the routing configuration

26 URRTOD->ROUTE |= UPLRT_ROUT E_TXPEN | UP_'.RT_ROUT E_RXPEH;
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Appendix: code —a working version

//USBRT IntClear (USART TypeDef *usart, uint32 t flags)
USERT IntClear (UBRTO, USART IFC MASK);

o ao

= o

//USBRRT IntEnable (USART TypeDef *usart, uint32 t flags)

USART IntEnable (UART0, USRRT IEN RXDATRV);

//woid  NVIC ClearPendingIRQ(IRQn Type IRQn)
__ NVIC ClearPendingIRQ(UART(0 RX IRQn);

//woid  NVIC EnableIRQ(IRQn Type IRQn)
__ NVIC EnableIRQ(UARTO RX IRQOn);

o ao

=] o T Oy R O O S LnLn
=] O LN o= Ld [N

1 =]
= o

/* Infinite loop */

while (1) {
72 //USBERT StatusGet (USART TypeDef *usart)
73 /it I:L':P‘R':‘_StatUEGet (URRTO) & USART STATUS RXDATAV)
74 I/ USRRT Tx (URRTO, USRERT RX (URRTO) ) ;
75 /] ]
76 }

|
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